Power BI Notes

Introduction

The Home tab contains general settings and common table transformation tools.

The Transform tab, contains tools to modify existing columns (splitting/grouping,

transposing, extracting text, etc.)

The Add Column tab creates new columns (based on conditional rules, text operations,

calculations, etc.)

Connecting & Shaping Data

Storage and connection modes

Power BI supports several types of storage and connection modes:

e Import: Tables are stored in-memory within Power BI, and queries are fulfilled by
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cached data (default).
o Dataset is less than 1GB.
o Storage data does not change frequently.
o No restrictions on Power Query, data modelling, and DAX functions.

DirectQuery: Tables are connected directly to the source, and queries are executed on-

demand at the data source.
o Dataset is too large to be stored in-memory.
o Source data changes frequently, and reports must reflect changes.
o Company policies states that data can only be accessed from the original source.

Composite Model (Dual): Tables come from a mix of import and DirectQuery modes,

or integrate multiple DirectQuery tables.
o Boost performance by setting appropriate storage for each table.
o Combine a DirectQuery model with additional imported data.
o Create a single model from two or more DirectQuery models.

Live Connection: Connects to a Pre-published Power BI datasets in Power BI Service or

Azure Analysis Services.



o Create one dataset that serves as a central source of truth.
o Analyst teams can create different reports from the same source.

o Multi-developer teams where one user builds the model, and another works on
visualization.

Note: Many tools can be accessed from both the Transform and Add Column menus, the

difference is whether we want to ADD a new column, or OVERWRITE an existing one.

Date & Time Tools
They include:

e Age: Difference between the current date and the date in each row.
¢ Date Only: Removes the time component from a date/time field.

¢ Year/Month/Quarter/Week/Day: Extracts individual components from a date field

(time-specific options include Hour, Minute, Second, etc.)

e Earliest/Latest: Evaluates the earliest or latest date from a column as a single value (can

only be accessed from the “Transform” menu)

If we have a Start of Week step, and we want to set the start of the week to be Monday, we
need to press the gear icon, and add an optional secondary parameter (which can be 1 for
Monday):

Date.StartOfWeek([Date], 1

Or we can also do:

Date.StartOfWeek([Date], Day.Monday

Change type with Locale
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name it “Rolling Calendar”
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Change Type with Locale
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2) Select Date as the data type and English
(United States) as the [ocale for all datasets in
this course {regardless of your actual location)

o In the formula bar, type a “literal” to generate a start data:

fe | =tdate(2020,1,1) v

Farmat as: Yy, MM DD

©

= List.Dates( -~
Source,
Number ., From(DateTime. LocalNow()) - MNumber.From(Source),
#duration(l, @, &8, @)
)

Click the fx icon to add a custom step, and enter the following formula To
generate a list of dates between the start date and the current day:

Note: If vour first aoplied step (s nomed something other thon “Source”, use that
name i your formuia {[this is common for non-US users)



e Convert the resulting list into a Table Rename the column 1o “Date” and add calculated date columns

and set the data type a5 a Date {year, month, quarter, etc.) using the Add Column tools
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Grouping & Aggregating

Home Transform add Calumin Wiew 1
Smapase pma e wiae e, GTOUP By allows you to aggregate data at a different level or “grain”
= ([ Reverse Rows [ Detect Data Type {t.e. group daily records into manthly, aggregate transactions by stare, etc.)
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Here we're transforming o doily, transoction level toble into o
summary of Total Quantity by Product Key

NOTE: Any fields not specified in the Group By settings are lost
Pivoting & Unpivoting

Pivoting describes the process of turning distinct row values into columns, and unpivoting
describes the process of turning distinct columns into rows.
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Merging & Appending Queries
=

:'—_ Merge Queries - Merge
i Append Queries - UL I NI bt e T g Merging queries allows you to join tables based

spali= o - . — on a common column (like a lookup in Excel}

Combine
> In thiz case we're merging the Soles Data toble with the Product
< >

Lookup ieble, which share a common Product Key colunn

NOTE: \Merging odds columns to an existing toble/query

Just because you can merge tables, doesn't
mean you should!

rnmany cases, it's better to keep tables
separzts and define relationships betweaen
them in the data model (more on that soon!)

We have two options:

¢ Merge Queries: Will append the other columns to the current query, preserving the items
that it originally had.

e Merge Queries as New: Will create a new query with only the original, and merged

queries
After that, we can expand the table using the arrows icon on the right.

And appending allows us to combine or stack tables sharing the exact same column structure

and data types. Grouping makes the table wider, whereas appending makes it taller.

Appending makes a query dependant on the queries that it used to create the table, to avoid
this dependencies on other queries, and having redundant data, the files can be added to a
folder, and the folder can be loaded.
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Data source parameters

Lse parameters to dynamically manage and update connection paths in the Power Query editor
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That can be used to switch from a development to a production environment, for example.

Refreshing Queries

File Hame Insert Modeling e Optirnize Help Extemal Tools
s =1 e o I P — M
1 MR ™dm @ | F 5
O i N & o B|lo
Faste Get  Ewcel  Data 50U Enter Dataversz  Recent Tranedanm| Refresh
data = wockogok buas Server dafn SGurCEs = caky
Higheard 1t uuasm

By defzult, el gueries will refresh when you use the
Refresh comrmand fram the Home tab

From the Query Fditor, uncheck Include in report refresh
to exclude individual queries from the refresh

Exclude gqueries from refresh that don't

E:h

change often (like lookups or static data tables)

Best practices:
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‘_\( Get organized before connecting and loading data

» Define clear and intuitive fable/Query names fram the staet, ond estabish an argonized fleffalder structurs if

you are working with locarl figt files to avoid chonges to file names ar poths

'\( Disable report refresh for any static data sources

= Theres no oeed bo constanthe refresh data sources Shat don't change, ke lookoos or stotis dota tabies

“( When working with large tables, only load the data you need

s+ Don'tinciude haurly dala when vou only heed doliy, of transaction level data when only heed o product leve!
sureenary (esieg oalo el grily siow your report downl)

Creating a Data Model

Fact & Dimension Tables

Data models generally contain two types: fact (data) tables, and dimension (lookup) tables:

¢ Fact tables contain numerical values or metrics used for summarization (sales, orders,

transactions, pageviews, etc.)

¢ Dimension tables contain descriptive attributes used for filtering or grouping
(products, customers, dates, stores, etc.)
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Star & Snowflake schemas
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Hierarchies

Hierarchies are groups of columns that reflect multiple levels of granularity. For example, a
Geographic hierarchy might include Country, state, and city fields. They are treated as a
single item in tables and reports, allowing users to “drill up” and “drill down” through each
level.
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Data Model Best Practices
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“E’ Focus on building a normalized model from the start

« levernge relgtionshins and maoke sure tThat each table serves o clear, Jistingt purpose

<

{ Organize dimension tables above data tables in your model

+  This serves gs g wisuol rerminder thal (iters ohwavs fow “downsireorn™

_'t;, Avoid complex relationships unless absolutely necessary

« Aim to use 1to many table relotionships and one way filters whenever possible

71 Hide fields from report view to prevent invalid filter context

«  This forces report wsers to filter using primany keys from dimension tables

Calculated Fields with DAX

Data Analysis Expressions (DAX)

Data Analysis Expressions (commonly known as DAX) is the formula language that drives
the Power BI front-end. With DAX, we can:

¢ Go beyond the capabilities of traditional spreadsheets formulas, with powerful and

flexible functions built specifically to work with relational data models.

¢ Add calculated columns (for filtering) and measures (for aggregation) to enhance data

models.
— Two ways to use DAX —I
L
b EA— ITemal © 1 =P EY T
" e - o i
L ¥ MOV Vubal Gredurs = GLETIHCTOOUMT [3adue G ata [0rdurbumtsre]
o : .l\_ Lok e Lzi zuwrg Tatal Feverus = SO0 Selan Jere, Salen Onta
PRTTRFAN, T— | Tegirlonlly] = FELSTED3yimbort_Loskup[FiasdactPe2oe] 30
£ Cuailty Orgerad = SLH[Sales Datalr ferfuantity])

M and DAX are two distinct functional languages used within Power BI Desktop. M is used
in the Power Query editor, and is designed specifically for extracting, transforming and
loading data. Whereas DAX is used in the Power BI front-end, and is designed specifically

for analysing relational data models.
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Calculated Columns

Calculated columns allow you to add new, formula-based columns to tables in a model.
¢ They refer to entire tables or columns (no Al-style references.)

e Calculated columns generate values for each row, which are visible within tables in the

Data view.

e Calculated columns understand row context; they are great for defining properties based

on information in each row, but generally useless for aggregation (sum, count, etc.)

As a rule of thumb, use calculated
columns to “stamp” static, fixed
values to each row in a table (or go
upstream and use the Query Editor!)

DO NOT use calculated columns for
aggregation — this is what measures
are for!

For example:

d | X /|t Parent - IF(*Customer Lookup'[Total Children)>d, "Vas™, lic") -| Fields In this case we’ve added a calculated column named
- - —7 Parent, which equals “Yes” if the [Total Children] field is
greater than 0, and “No” otherwise

70000
20000
70000
Since calculated columns understand row context, a new
value is calculated in each row based on the value in the

[Total Children] column

130000

40000

70000
L This is a of calculated columns; it creates a
new row “property” that we can use to filter or segment

any related data within the model

Email Address

First Name

For example:
Quantity Type = IF

‘Sales Data'|OrderQuantity| > 1
"Multiple Items"
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"Single Item"

That will create a column that will contain Multiple Items if OrderQuantity is greater than

one, or Single Item otherwise.

DAX Measures

Measures are DAX formulas used to generate new calculated values.
e They also reference entire tables or columns (no Al-style cell references)

e Unlike calculated columns, measures aren’t visible within tables; they can only be
“seen” within a visualization like a chart or a matrix (similar to a calculated field in a
PivotTable)

e Measures evaluate based on filter context, which means they recalculate when the fields

or filters around them change.

Implicit vs Explicit Measures

Implicit measures are created when we drag raw numerical fields into a report visual and

manually select an aggregation mode (Sum, Average, Min, Max, Count, etc):
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El Build a visual

L | Visual types

] 0 v BB [ ~
(@or) Suggest a type

X-axis

Year x| > |
| +Add data

¥-axis

|

| sumoforder.. X | > |

| +Add data

[ +Add data

Small multiples

| +Add data

Tooltips

......... | +Add data

Select data

[ 2 search

# EH Froduct sUDCansgornes Loo...

» B8 Returns Data
» B Rolling Calendar
B Sales Data
Customer Key
Cirder Date
E Cirder Line Item
Order Mumber
2 Order Quantity
Product Key
B Quantity Type
[ Retail Price
m; Revenue
Stock Date
Territory Key
» B8 Territory Lookup

Example of an implicit measure

Whereas the explicit measures are created when we actually write a DAX formula and define

a new measure that can be used within the model.

Implicit measures are only accessible within the specific visualization
in which they were created, and cannot be referenced elsewhere

Explicit measures can be used anywhere in the report, and referenced

by other DAX calculations to create “measure trees”

Quick Measures
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Quick measures automatically create formulas based on pre-built templates or natural language prompts

Quick measure » X

Selec tion 1o create & measure or describe the measure

'l generane suggestions in DAY which you can

e

Weighted average per eategory

Quick measure

Calculate a weighted average of the base vahue for sach

category. Multiphy the akue by weight for each category, sum
tetal anel then i by the sum total of the weight. Learm
mare

can be used to build
measures using predefined templates (weighted
averages, percent difference, time intelligence, etc.) Calculations

Quick measure » X

Select a cakulation to create a measure or describe the measure
you need and we'll generate suggestions in DAX, which you can
customize later.

Sum of quantity sold by calendar lookup year x

Ba: lue @ " .
i Quick measure can be used to find
Sum of Ordes Quantity x| .
suggested measures based on natural language queries
Weight & (i.e. “sum of quantity seld by calendar year”) Gene.m
.
i Suggested measures

Add data

Calculated columns vs Measures

CALCULATED COLUMNS

Values are calculated based on information from each
row of a table (row context)

Appends static values to each row in a table and
stores them in the model (which increases file size)

Recalculate on data source refresh or when changes
are made to component columns

Primarily used for filtering data in reports

£
e
.
£
s
"
e

Calculated columns “live” in tables <«

Measure Tables

It’s a common best practice to create a dedicated table to store your measures; this will

Total quantity sold per year e

Values are calculated based on information from any
filters in the report (filter context)

Does not create new data in the tables themselves
(doesn’t increase file size)

Recalculate in response to any change to filters within
the report

Primarily used for aggregating values in report visuals

Keaxis @ oy Omer: @1 Asence

Aatd diata fields here

Cokumn y-axis

Total Orders v
Line y-axis

Total Revenue: e

Column legend

Ao data fields nere

Measures “live” in visuals

help you stay organised, find measures quickly, and allow you to group related measures into

folders. We can create them in two ways:

Power Bl Notes
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Option 1: Enter Data into Power Query (loads the table to the data model — table is visible in Power Query)

Create Table

File Home nsert  Modeling  View _ Optimize  Help
T BLO E‘Eﬁ@ B ==

Gat Excel Data SQL | Enter Dataverse Recent
L R A T o : Add a table Name and click OK to

*from .:::;:m-g = load the table to the data model

hame: [ers T ]

—

Option 2: Create a calculated table using DAX directly in the model (table is not visible in Power Query)

File Home  Help External Tools  Table tools il - |1 Measure Table (DAX) = {““} |
r B BT
<7 Name | Measure Table (DAX) | E = Value ad Create new table & use a table
Mark as da Manage New  Quick New | New constructor { } to add a single column
relationships ~ measure measure column| table

Structure Calendars Relationships Calculations @E

*from the Data view

To create a blank table, we can write the DAX:
Table Name = {""}
Which uses table constructors to basically create a blank table.

Measure Calculation

Praduct Color Quantity Sold . .
i [wm]— How exactly is this measure value calculated?
Red 40m
Yellow 4638 * NOTE: This all happens instantly behind the scenes, every time the filter context changes
A
- Rl
STEP 1 STEP 2 STEP 3
Filter context is detected & applied Filters flow “downstream” to related tables Measure evaluates against the
filtered table
Product Color Quantity Sold :_-:_ = _ o=
= == - Black = s 1 Quantity Sold =
ot e SEZ = = =E o)
Yellow 4638 = = 3 ‘Sales Data'[Order Quantity]
4)

"Product Lookup’[Praduct Color] = “Black

= — e 11
Product Lookup Table = = e _—

Sum of values in the Order Quantity

=
= 5 - column of the Sales Data table, filtered to
: Black - = W = rows where the product color is “Black”
: é - —=i= Black = E — 10 590
: = = = - = ’

DAX Syntax
Consider the following piece of DAX:

Total Quantity: = SUM(Transactions[quantity])
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In grey we have Measure Name. They are always surrounded by brackets (i.e. [Total

Quantity]) when referenced in formulas, so spaces are OK.

The component immediately following the equals sign (the one in yellow) is the function
name. Calculated columns don’t always use functions but measures do. In a measure column,
we couldn’t do something like = Transactions[quantity] but we can in a calculated column,
as it’s evaluated row by row. In a measure, Power BI wouldn’t know how to convert that into
a single value.

The table name is in orange, and the blue is the column name. If we were referencing a
different table with spaces, we’d need to enclose it within quotes, so we’d end up with

something like:

Total Quantity: = SUM ("Transactions Table"[quantity

The following are the DAX operators:

Arithmetic Operator Meaning Example
+ Addition 2+7
- Subtraction 5-3
* Multiplication 2*6
/ Division 4/2
A Exponent 275

Comparison operators:

Comparison Operator Meaning Example

= Equal to [City] = “Boston”

> Greater than [Quantity] > 10

< Less than [Quantity] < 10

> Greater than or equal [Unit Price] > 2.5

< Less than or equal to  [Unit Price] < 2.5

<> Not equal to [Country]<>”"Mexico”

Text operators and logical operators:

Text/Logical ]
Meaning Example
Operator

Power Bl Notes
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Concatenates two values to produce one

& . [City] & “ “ & [State]
string
& Creates an AND condition between two ([State]="MA”) && ([Quantity]
logical expressions >10)
Creates an OR condition between two ([State]="MA”) ||
I logical expressions ([State]="CT”)
IN Creates a logical OR condition based on a “Store Lookup”[State] IN
given list (using curly brackets) {"MA”, “CT”, “NY”}

Common Function Categories

r
L
Functions used for Functions that use Functions used to Functions used to Functions that create or Functions used to Functions used to
aggregation o conditional expressions manipulate text strings manipulate table and manipulate tables ond manipulate date & time manage & modify
iterative, row-level (IF/THEN statements) or value formats filter contexts output tables vs. scalar values or handle time table relationships
calculations values intelligence calculations
Common Examples: Common Examples: Commen Examples: Common Examples: Common Examples: Commeon Examples: Common Examples:
+ SUM « IF * CONCATENATE * CALCULATE * SUMMARIZE * DATE * RELATED
= AVERAGE = IFERROR * COMBINEVALUES * FILTER = ADDCOLUMNS « DATEDIFF * RELATEDTABLE
+ MAX/MIN = AND *  FORMAT + ALL = GENERATESERIES * YEARFRAC * CROSSFILTER
* DIVIDE * OR = LEFT/MID/RIGHT = ALLEXCEPT *  DISTINCT « YEAR/MONTH *  USERELATIONSHIP
+ COUNT/COUNTA - NOT + UPPER/LOWER * ALLSELECTED = VALUES « DAY/HOUR
= COUNTROWS = SWITCH * LEN * KEEPFILTERS = UNION +  TODAY/NOW
+ DISTINCTCOUNT = TRUE + SEARCH/FIND * REMOVEFILTERS = INTERSECT ¢ WEEKDAY
« FALSE * REPLACE * SELECTEDVALUE + TOPN * WEEKNUM
Iterator Functions: + SUBSTITUTE «  NETWORKDAYS
o sumx T Time Intelligence:
= AVERAGEX
+ MAXX/MINX « DATESYTD
*  RANKX * DATESMTD
* COUNTX * DATEADD

* DATESBETWEEN

Basic maths & stats functions
¢ SUM: Evaluates the sum of a column: =SUM (ColumnName)

¢ AVERAGE: Returns the average (arithmetic mean) of all the numbers in a column:
=AVERAGE (ColumnName)

e MAX: Returns the largest value in a column or between two scalar expressions: =MAX
(ColumnNameOrScalarl, [Scalar2])

e MIN: Returns the smallest value in a column or between two scalar expressions:
=MIN(ColumnNameOrScalarl, [Scalar2])

e DIVIDE: Performs division and returns the alternate result (or blank) if DIV/0:
=DIVIDE(Numerator, Denominator, [AlternateResult])

Count Functions
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COUNT: Counts the number of non-empty cells in a column (excluding Boolean

values), can only be used with numbers. =COUNT (ColumnName)

COUNTA: Counts the number of non-empty cells in a column (excluding Boolean
values), can be used with both numbers, and text: =COUNTA (ColumnName)

DISTINCTCOUNT: Counts the number of distinct values in a column:
=DISTINCTCOUNT (ColumnName)

COUNTROWS: Counts the number of rows in the specified table, or a tabled defined
by an expression: =COUNTROWS ([Table])

o Note: The definition of Table in Power Bl is either a column, or an entire table.

Conditional & Logical Functions

IF: Checks if a given condition is met and returns one value if the condition is TRUE and
another if the condition is FALSE: =IF (LogicalTest, ResultlfTrue, [ResultIfFalse])

IFERROR: Evaluates an expression and returns a specified value if it returns an error,
otherwise returns the expression itself: =IFERROR (Value, ValuelfError)

SWITCH: Evaluates an expression against a list of values and returns one of multiple
possible expressions. =SWITCH (Expression, Valuel, Resultl, ..., [Else])

AND: Checks whether both arguments are TRUE to return TRUE, otherwise returns
FALSE. =AND (Logicall, Logical2)

OR: Checks if at least one argument is TRUE to return TRUE, otherwise returns FALSE.
=OR (Logicall, Logical2)

The switch function

= (Expression, Valuel, Resultl, ..., )
/'I "
" p /
T I - S —.
L L)
Any DAKX expression that returas a single LisL ol values procucad by Lhe Walue relurned il the
sialan value, evaluaied mulliphes drmes caprrnsien, cach pairnd with o resut capressinn dorsn’t match
Lo reburn Moe romesdoases Lhal match arwy walue grpumen|
Excarmples,
ahani h Fiiiites:

ot mep it pan -

Cwlen s onth (D),

L Iy |

Switch is used mainly to test for equality, if we wanted to use other operators, we could do:

Power Bl Notes
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Price Point = SWITCH
TRUE
'‘Product Lookup'[ProductPrice] > 500, "High"
'Product Lookup'[ProductPrice] > 100, "Mid-Ran

ge
"LOW"

Text Functions

LEN: Returns the number of characters in a string: =LEN (Text)
CONCATENATE: Joins two strings into one: =CONCATENATE (Text1, Text2)
UPPER/LOWER: Converts a string to upper or lower case: =UPPER/LOWER (Text)

LEFT/RIGHT/MID: Returns a specified number of characters starting from the
left/right/end of a string.

o =LEFT/RIGHT (Text, [NumChars])
o =MID (Text, StartPosition, NumChars)

SUBSTITUTE: Replaces an instance of existing text with new text in a string:
=SUBSTITUTE (Text, OldText, NewText, [InstanceNumber])

SEARCH: Returns the position where a specified string or character is found, reading
left to right: =SEARCH (FindText, WithinText, [StartPosition], [NotFoundValue])

Basic Date & Time Functions

Power Bl Notes

TODAY/NOW: Returns the current date or exact time: =TODAY/NOW ()

DAY/MONTH/YEAR: Returns the day of the month (1-31), month of the year (1-12),
or year of a given date: =DAY/MONTH/YEAR (Date)

HOUR/MINUTE/SECOND: Returns the hour (0-23), minute (0-59), or second (059) of
a given datetime value: =HOUR/MINUTE/SECOND (Datetime)

WEEKDAY/WEEKNUM: Returns a weekday number from 1 (Sunday) to 7 (Saturday),
or the week number of the year: =WEEKDAY/WEEKNUM (Date, [ReturnType])

EOMONTH: Returns the date of the last day of the month, =/- a specified number of
months: =EOMONTH (StartDate, Months)



e DATEDIFF: Returns the difference between two dates, based on a given interval (day,
hour, year, etc): =DATEDIFF (Datel, Date2, Interval)

Joining Data with RELATED

The RELATED function returns related values in each row of a table based on relationships

with other tables:

I

(ColumnName)

RELATED works like a VLOOKUP function in Excel —it uses the
The column from a related table containing relationship between tables (defined by primary and foreign keys)

the values you want to retrieve to pull values from one table into a new column of another.

Since this function requires row context, it can only be used as a
calculated column or as part of an iterator function that cycles

Product L”"*“p"'r{”_cd”“ Name] through all rows in a table (FILTER, SUMX, MAXX, etc.)
. “Territory Lookup’{Countryj

Examples:

The CALCULATE Function

The CALCULATE function evaluates an expression in a context that is modified by filters.

= (Expression, )
A S
~"

Name of an existing measure or a DAX formula A Boolean (True/False) expression or a table expression that defines a filter
for a valid measure Note: these require fixed values or aggregation functions that return a scalar
Examples: value (you cannot create filters based on measures)

[Totai Orders] Examples:

SUM("Returns Data’[Return Quantity]) «  “Territory Lookup'[Country] = “

*  Calendar{Year| <> (Calendar{Year])

9
@: Think of CALCULATE as a filter modifier; it allows you to overrule existing report filters and “force” new filter context

Take into account this:

Power Bl Notes



CALCULATE If the measure being evaluated contains a CALCULATE function,

Filters are modified by CALCULATE filter context is overwritten between Step 1 & Step 2
[Product Color] = “Red”

STEP 1 STEP 2 STEP 3

Filter context is detected Filters flow “downstream” M v the
& applied i to related tables filtered table
= Red=—r—%
e =

Product Color guantity Sold Red Sales = = = 2 Z 1 Quantity Sold =

Black 10,590 4,011 — Red = = 2 suM( 'Sales Data’[Order Quantity] )
Red 4011 4,011 = v =4

Silver 3,257 40m : = =

Sum of the Order Quantity colurn in the

‘Product Lookup’[Product Color] = “Black” Sales Data table, filtered to rows where
==

the product color is “Red”

=4,011

Note: This sum doesn’t add up to the correct value:

CategoryName Total Orders Weekend Orders

+ Accessories 16,983 4913
= Bikes 13,929 3,995
# Clothing 6,976 1,962

Total 25,164 7,214

because the total is a DISTINCTCOUNT so, for example, if in an order an accessory and a
bike was bought, it’d add one to both of them, but only one to the total.

The ALL Function

The ALL function returns all rows in a table, or all values in a column, ignoring any filters
that have been applied.
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Returns all rows in a table, or all values in a column, ignoring any filters that have been applied

=ALL(Table or Column, )
Y - v ~
'he table or column that you Additional columns that you want to clear filters on (optional)

want to clear filters on *  Cannot specify columns if your first parameter is a table

Examples: *  All columns must include the table name and come from the same table

Transactions Examples:

Products{Categor,
[Category] . ‘Customer Lookup’[City], ‘Customer Lookup’[Country]

ProductsfProduct Name]

If we want to do calculations over all the elements of a column without the filter context, we

could do this:

Overall Average Price = CALCULATE (
'Average Retail Price],
ALL ('Product Lookup')

The FILTER Function

The FILTER function returns a table that represents a subset of another table or expression:

= (Table, FilterExpression)

/

Y FILTER is used to add new filter context,
Table to be filtered A Boolean (True/False) filter expression to be and Can_handle more complex filter
evaluated for each row of the table expresspns than CALCULATE (by
Examples: referencing measures, for example)
Examples:

Territory Lookup i . .
Customer Lookup - “Teritory Lookup’[Country] = Since FILTER returns an entire table, it’s

+  Calendar{Year] = often nested within other functions, like
Products{Price] > CALCULATE or SUMX

@ Since FILTER iterates through each row in a table, it can be slow and computationally expensive; only use FILTER if a
simple CALCULATE function won't get the job done!

ITERATOR (X) Functions

Iterator (or “X”) functions allow you to loop through the same expression on each row of a

table, then simply apply some sort of aggregation to the results (SUM, MAX, etc):
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=SUMX(Table, Expression)

Aggregation to apply to Table in which the Expression to be evaluated for
calculated rows* expression will be evaluated each row of the given table
Examples: Examples: Examples:
SUMX *  Sales = [Total Orders]
COUNTX *  FILTER(Sales, *  Sales[Retail Price] * Sales[Quantity]
AVERAGEX RELATED(ProductsfCategory])="Clothing”)
RANKX
MAXX/MINX

6 Imagine that iterator functions add a temporary new column to a table, calculate a value in each row based on the
given expression, then aggregate the values within that temporary column (similar to SUMPRODUCT in Excel)

Time Intelligence

Time Intelligence patterns are used to calculate common date-based comparisons:

i {al e s =CALCULATE(Measure, DATESYTD(Calendar[Date]))

To-Date Use DATESYTD for Years, DATESQTD for Quarters, DATESMTD for Months

Previous =CALCULATE(Measure, DATEADD(Calendar[Date], -1, MONTH))

Period

Select an interval (DAY, MONTH, QUARTER, or YEAR) and the
# of intervals to compare {e.qg. previous manth, rolling 10-day)

Running =CALCULATE(Measure, i
Total DATESINPERIOD(Calendar[Date], MAX(Calendar[Date]), -10, DAY))

DAX Best Practices

"/* Know when to use calculated columns vs. measures

* Use calculated columns for filtering, and measures for aggregating values

‘:% Use explicit measures, even for simple calculations

*  Explicit measures can be referenced anywhere, and nested within other measures

'/k Use fully-qualified column references in measures

* This makes your DAX more readable, and differentiates column references from measure references

'/\' Move column calculations “upstream” when possible

* Adding calculated columns at the source or in Power Query improves report speed and efficiency

'/i’ Minimize the use of “expensive” iterator functions

*  Use jterators with caution, especially if you are working with large tables or complex models
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HASONEVALUE

The HASONEVALUE function is used to determine if a column has a single distinct value in
the current context: =HASONEVALUE (Column)

For example, if we want to display only one customer in a customer lookup table, we could
do:

Customer Full name (Customer Details) = IF
HASONEVALUE
'‘Customer Lookup'[CustomerKey

MAX
‘Customer Lookup'[Full Name

"Multiple Customers"

Visualizing Data with Reports

Drill Through Filters

Drill through filters allow users to navigate to a specific report page, pre-filtered on the item selected

Here we've created a Product Detail page, set the type to Drillthrough, and configured drill through from Product Name

* This means that users can right-click any instance of product name (i.e. in a matrix visual) and use the Drill through option
to navigate straight to the Product Detail report filtered on that product (in this case “Mountain Tire Tube”)

Format v X

Mountain Tire P Search
WS 275 $2,735 $1.710

[ Top 10 Products

v Page information

Name

Product Detail

Page type

Drillthrough ~
Keep all filters (om0
Cross-report a

Drill through from
Fc-m.c: Name X

+Add data

Report Interactions
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Edit report interactions to customize how filters applied to one visual impact other visuals on the page

* Cross-filter options include filter ( 15, ), highlight ( il ) and none ( () ), depending on the visual type

Format > Edit Interactions

Weekly Revenue Orders by Category

{B | Top 10 Products Orders Revenue Return %

LTl
o
<

<
&
o -
A‘,
£ <
N
—
L]

/]

In this example, selecting a

product in the matrix visual:
Filters the line chart & KPIs
Highlights the bar chart

Doesn’t impact the text cards

Q
]
i
i
|

To change the report interactions, we find its button on the Format > Edit Interactions

button.

Note: If two or more filters want to be applied, we need to press CTRL when we apply them

so that they are stacked.

Slicer Panels

Slicer Panels can be created using buttons that lead to bookmarks with the Data checkbox

disabled.

Numeric Ranges

Numeric Ranges can be used with slicers to change a value. They are created under the

Modelling > New Parameter tab. They will create two measures: one containing the value,

and another one containing the possible values.

Note: We can set the title of an element to one of a range (i.e. a fields) using the Fx button.

Managing & Viewing Roles

We can create custom roles under the Modelling > Manage Roles button.

Data Visualization Best Practices
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'\( Always ask yourself the three key questions

What type of data are you visualizing, what are you communicating, and who is the end user?

"‘( Strive for clarity and simplicity above all else

*  “Perfection is achieved not when there’s nothing more to add, but when there’s nothing left to take away”

"( Focus on creating clear narratives and intuitive user experiences

*  Use bookmarks, drillthroughs, tooltips and navigation buttons to seamlessly guide users through reports

"( Create optimized layouts for mobile viewers

*  Create custom mobile layouts if you plan to publish reports to Power Bl Service or use the Power Bl app
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